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Copyright 
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The information contained in this document is subject to change 

without notice. 

We make no warranty of any kind with regard to this material, 

including, but not limited to, the implied warranties of 

merchantability and fitness for a particular purpose. We shall not 

be liable for errors contained herein or for incidental or 

consequential damages in connection with the furnishing, 

performance, or use of this material. 

 

This document contains proprietary information that is protected 

by copyright. All rights are reserved. No part of this document 

may be photocopied, reproduced or translated to another 

language without the prior written consent of the manufacturer. 
 

TRADEMARK 
The material in this manual is subject to change without notice. 

Bluetooth is a registered trademark of Bluetooth SIG.  

Microsoft®, Windows® and ActiveSync® are either registered 

trademarks or trademarks of Microsoft Corporation.  

All other product or service names are the property of their 

respective owners. 
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Revision History 
Changes to the original user manual are listed below: 

 

Version Date Description 

1.0 2010/03  Initial release 

1.1 2010/08  Power Button and LED changed 

 New Hand Strip, Stylus, Stylus Strip 

phased in 

 Optional MSR added 
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Safety 
Regulatory Information: 

Caution: Only use approved and UL Listed accessories, battery 

packs and battery chargers. Do NOT attempt to charge 

damp/wet mobile computers or batteries. All components must 

be dry before connecting to an external power source. 

 

Power Supply 

Use only the approved power supply 50-14000-148 output rated 

5 Vdc and minimum 2 A. The power supply is certified to 

EN60950-1 with SELV outputs. Use of alternative power supply 

will invalidate any approval given to this device and may be 

dangerous. 

 

Warning for Use of Wireless Devices 

Please observe all warning notices with regard to the usage of 

wireless devices. 

 

Potentially Hazardous Atmospheres 

You are reminded of the need to observe restrictions on the use 

of radio devices in fuel depots, chemical plants etc. and areas 

where the air contains chemicals or particles (such as grain, dust, 

or metal powders) 

and any other area where you would normally be advised to turn 

off your vehicle engine. 

 

Safety in Aircraft 

Switch off your wireless device whenever you are instructed to 

do so by airport or airline staff. 

 

Pacemakers 

Pacemaker manufacturers recommended that a minimum of 

15cm (6 inches) be maintained between a handheld wireless 

device and a pacemaker to avoid potential interference with the 

pacemaker. These recommendations are consistent with 

independent research and recommendations by Wireless 

Technology Research. 
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Persons with Pacemakers: 

Persons with Pacemakers should ALWAYS keep the device 

more than 15cm (6 inches) from their pacemaker when turned 

ON and hence they should not carry the device in a breast 

pocket . 

Should use the ear furthest from the pacemaker to minimize the 

potential for interference. 

If you have any reason to suspect that interference is taking 

place, turn OFF your device. 

 

 

Hearing Aids 

The wireless device may interfere with some hearing aids. In the 

event of interference you may want to consult your hearing aid 

supplier to discuss solutions. 

 

Other Medical Devices 

Please consult your physician or the manufacturer of the medical 

device, to determine if the operation of your wireless product may 

interfere with the medical device. 

 

 

 

FCC / EU RF Exposure Guidelines 
Safety Information 

This device complies with internationally recognized standards 

covering Specific Absorption Rate (SAR) related to human 

exposure to electromagnetic fields from radio devices. 

The maximum level of Specific Absorption Rate (SAR) measured is  

0.683W/kg. 

 

Reducing RF Influence - Use Properly 

It is advisable to use the device only in the normal operating 

position. 

 

Handheld Devices 

This device was tested for typical body-worn operation. Use only 



 vi 

tested and approved belt-holsters, hand strip and similar 

accessories to ensure FCC Compliance. The use of third-party 

belt-clips, holsters, and similar accessories may not comply with 

FCC RF exposure compliance requirements, and should be 

avoided. 

To comply with FCC RF exposure requirements, this device must 

be operated in the hand .Other operating configurations should 

be avoided. 

 

Radio Frequency Interference Requirements - FCC 

This device complies with Part 15 of the FCC Rules. Operation is 

subject to the following two conditions: (1) this device may not 

cause harmful interference, and (2) this device must accept any 

interference received, including interference that may cause 

undesired operation. 

 

Radio Frequency Interference Requirements – IC 

This device complies with RSS-210 of the IC Rules. Operation is 

subject to the following two conditions: (1) this device may not 

cause harmful interference, and (2) this device must accept any 

interference received, including interference that may cause 

undesired operation. 

 

 

 CE Marking and European 

Economic Area (EEA) 
The use of 2.4GHz RLAN's, for use through the EEA, have the 

following restrictions: 

 Maximum radiated transmit power of 100 mW EIRP in the 

frequency range 2.400 -2.4835 GHz 

 France, outside usage is restricted to 2.4 - 2.454 GHz. 

 Italy requires a user license for outside usage. 
 

Bluetooth® Wireless Technology for use through the EEA has 

the following restrictions: 
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 Maximum radiated transmit power of 100mW EIRP in the 

frequency range 2.400 -2.4835 GHz 

 France, outside usage is restricted to 10mW EIRP 

 Italy requires a user license for outside usage. 
 

 

 

Battery Information 
Our rechargeable battery packs are designed and constructed to 

the highest standards within the industry. 

However, there are limitations to how long a battery can operate 

or be stored before needing replacement. 

Many factors affect the actual life cycle of a battery pack, such as 

heat, cold, harsh environmental conditions and severe drops. 

When batteries are stored over six (6) months, some irreversible 

deterioration in overall battery quality may occur. Store batteries 

discharged in a dry, cool place, removed from the equipment to 

prevent loss of capacity, rusting of metallic parts and electrolyte 

leakage. When storing batteries for one year or longer, they 

should be charged and discharged at least once a year. If an 

electrolyte leakage is observed, avoid any contact with affected 

area and properly dispose of the battery. Batteries must be 

charged within the 32° to 95° F (0° to +35° C) ambient 

temperature range. 
 

 

 

  Battery Caution 
Risk of explosion if battery is replaced by an incorrectly type.  

Dispose of used battery according to the local disposal 

instructions. 
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 Waste Electrical and Electronic 

Equipment (WEEE)  
English: For EU Customers: All products at the end of their life 

must be returned to the reseller for recycling. 



 ix

Notational Conventions 
The following conventions are used in this document: 

 Italics are used to highlight specific items in the general text, 

and to identify chapters and sections in this and related 

documents. 

 bullets (•) indicate: 

 action items 

 lists of alternatives 

 lists of required steps that are not necessarily sequential 

 Sequential lists (e.g., those that describe step-by-step 

procedures) appear as numbered lists. 

NOTE This symbol indicates something of special interest or 

importance to the reader. Failure to read the note will not result in 

physical harm to the reader, equipment or data. 

CAUTION This symbol indicates that if this information is ignored, 

the possibility of data or material damage may occur. 

WARNING! This symbol indicates that if this information is 

ignored the possibility that serious personal injury may occur. 
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1   Introduction 
This chapter introduces the parts, accessories of the mobile system. 

 

1-1 System Overview 
      

 

 

System Overview table 

 Location 

1 3.5” TFT with Touch Screen  

2 I/O Cover    

3 Micro SD slot 

4 Mini USB connector 

5 Charging Slot 

6 Power Button & LED Indicator 

7 Reset Hole 

8 Speaker 

9 Hand Strip / Wrist Strip / Stylus Strip Installation Ring 

10 MSR module 
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1-2 Standard Components 

 

 
 

 Items 

1 Mobile system 

2 Holster  

3 Single slot system charger Cradle 

4 Hand strip 

5 Wrist strip 

6 Stylus 

7 Stylus strip 

8 USB cable (connecting with PC for synchronization) 

9 USB-AC Adapter for connecting to single slot system charging cradle 

10 MSR module (optional; will be installed to system prior to shipping) 
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1-3 Hardware Description 
 

Item Features Descriptions 

1 Main Processor  Marvell PXA270 416MHz (Xscale Core) 

2 System Memory  128Mbytes SDRAM  

 Around 115MB use for system operation, 

otherwise for storing system loader and system 

data 

3 System Storage  1Gbytes Flash (ROM file system) 

 More than 300MB for storing WindowCE image 

and OEM application programs 

 Around 600MB leaved for system and user 

storage, emulated as folders in all system 

directories 

 Around 100MB leaved for storing OEM data and 

configurations This device provides a specific 

mechanism to let system integrator easily to 

integrate the OEM applications and device 

configurations into device as factory default mode 

without merging OEM applications into 

WindowCE image It can help system integrator 

doesn’t have to maintain the device after end user 

crashed the device by reset device to factory 

default mode or on-line updated the OS image 

from internet 

4 Display  PXA270 Display controller 

 Share System Memory as Video Frame Buffer 

 Resolution :320 x 240 pixels, 16 bit color 

 4 way rotator for direction detection  

5 LCD  3.5” inches TFT LCD – QVGA (320 x 240 pixels 

resolution) 

 Transmissive display mode 
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Item Features Descriptions 

6 Touch Panel  LCD panel with touch panel design 

 Resistor 80% Transparency (Film to Glass type) 

7 Audio  Stereo audio system with mono speaker design 

 1W speaker amplifier 

8 Secure Digital 

Socket 

 Micro SD memory card (Support up to: 2Gbytes)

9 WiFi IEEE 

80211b/g 

 Auto fallback mode : 6M~54M(80211g), 

1M~11M(80211b) 

 Complying with Wireless Ethernet Compatibility 

Alliance 

 Support hardware signaling BT WiFi co-existence

 Link LED indicator 

 Maximum Output Power : 

+14dBm(Avg)/+21dBm(Peak) 

10 Bluetooth  Compliant with Bluetooth Specification V2.0 

 Maximum Output Power : +0dBm (Class 

2)(Avg)/+2dBm(Peak) 

 Receive Sensitivity : Typical -78dBm 

11 USB Client  USB Specification - 11 compliant 

 Full-Speed operation on half-duplex at 12Mbps 

baud rate 

12 USB Host  Compliant with USB Specification 11 and OHCI 

Spec 

 Support both low-speed and full-speed USB 

devices 

 Support optional device (either one of the MSR 

reader, IC card reader, Barcode scanner, and so 

on) 
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Item Features Descriptions 

13 Power / Reset 

buttons 

 Power Button : Suspend/ Resume Device and 

Power-on Key 

 Reset Button : Warm Reset  

 Press Power and Reset buttons simultaneously: 

Cold Reset 

14 LED indicators  Green: Battery power charging finished 

 Orange: Battery power charging 

 Blue: Wifi link active 

 Red: Flash – Battery low,  

     ON – Critical battery low 

15 Vibrator  Vibrational indicator 

16 Battery  Li-Polymer battery pach, 3.7V, 1500 mA/H 

 Charging time : maximum 4.0 ~ 4.5Hours 

 Thermal / Over Charging Protections 

17 Adapter  AC110V ~ 240V / DC5V ( 10W ) 50~60Hz 
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1-4 System Feature Description 
 

Item Features Descriptions 

1  Application  File Explorer 

 Internet Explorer 6.0 for Windows CE

 Windows Media Player 

 Windows CE standard shell 

(Windows XP-like skin) 

2  File System  ROM File system with hive registry 

3  Graphic / Display  320x240x16 (Landscape mode) as 

panel default mode 240x320x16 

(Portrait mode) as system default 

mode 

 Compliant with Graphics, Windowing 

and Event Subsystems of Window 

CE embedded. 

 Still Image Codec Support 

 DirectShow 

 Support screen rotation feature 

4  User Input 

Interface 
 Stylus input rather than mouse input 

capability 

5  Audio  Audio playback feature only 

 Support waveform audio 

Input/Output device APIs 

 Configurable sound enable/disable 

feature of system event, message 

notification, screen taps. 

 MP3 Codec 

 MPEG-1 Layer 1 and 2 audio codec 

 Waveform audio renderer 

 WMA Codec 
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Item Features Descriptions 

6  Storage  Removable storage : Micro SD 

memory (up to 2GB) 

 Persistent storage: NAND flash 

memory (On Board) 

7  Data 

Communication 

WLAN 

 Support seamless roaming in 

IEEE802.11b/g WLAN authentication 

infrastructure 

 Support single SSID 

 Support fast Wi-Fi roaming 

 WPA and 802.11i security standard 

(AES/CCMP and WEP with TKIP 

security mechanism) 

 Support Window Wireless Zero 

Configuration service 

8  Data 

Communication 

Bluetooth 

 Compliant Bluetooth software 

specification 

 Window CE Bluetooth 

communication software stack 

 “SPP” “FTP” “Activesync” profile 

supports 

 Support Winsock Bluetooth 

programming interface  

9  Data 

Synchronization 
 Bluetooth Window CE Active-sync 

 USB Active-Sync 

10  Vibration 

Notification 
 Support Programming API of 

Window CE device manager 

11  System Power 

State 
 Support Remote Application 

Interface (RAPI) for retrieves the 

power state of system 

: Battery Status / AC status 

12  Backlight  Support Programming API of 

Window CE device manager 

 Support 10 backlight scales 
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Item Features Descriptions 

13  Network Features  NDIS network driver architecture 

 TCP/IP 

 Windows Networking API /Redirector 

[SMB] 

 WinSock Support 

14  Security  Authentication Services (SSPI) 

 Credential Manager 

 CrytoAPI 1.0 

15  Applications and 

Service 

Development 

 .NET compact framework 2.0 

 Active Template Library (ATL) 

 C Libraries and Runtimes 

 COM and DCOM 

 Microsoft Foundation Classes (MFC)

 Object Exahange Protocol 

 Standard SDK for Windows CE 

 MSXML 3.0 

16  Fonts  Courier New (Subset 1_30) 

 Tahoma (Subset 1_07) 

 Wingding 

17  Multilingual  English (English software Input 

Panel) 

 Traditional Chinese 
 (Bopomofo/ Chan Jei software Input 

Panel, Handwriting) 

 Simplified Chinese (Shuang Pin 

software Input Panel) 

18  OEM  OEM Device Manager 

 User mode / Admin mode operation 

modes 
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2   Getting Started 
 

2-1 Installing / Uninstalling a Micro SD Card 
 

      
1. Release the screws (x1) to open the I/O cover on the side of the 

mobile system. 

2. The Micro SD card slot is a push-push type, please push the Micro 

SD card into or outward from the slot to install or remove it. 

3. To cover the I/O cover again. 

2-2 Install a Wrist Strip 

 

1. Thread the wrist strip through the strip ring as picture shown. 
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2-3 Install a Hand Strip / Stylus Strip 

 

 
1. Thread the hand strip through the strip rings on the rear top and 

rear bottom sides of the system.  Fix the hand strip by pressing 

the velcro at two ends. (as arrows shown) 

2. To fasten the stylus, thread the stylus strip through the strip rings 

on the system rear side and the hole on the stylus. 

3. The stylus can be held inside the hand strip. 
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2-4 Charge the System 
 

        

 

 

1. Connect the mini USB connector of the AC-USB adapter to the rear 

of the single-slot system charging cradle. 

2. Connect the power cord of the AC-USB adapter to the power 

outlet. 

3. Slide correctly into the single-slot system charging cradle until you 

see the charging LED light appears. 
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2-5 Power on/off the System 
 

 

 

Turn on the System 

Press and hold the Power Button (as the arrow marked) for 3 seconds to 

turn on the system. 

 

Turn off the System 

To press the Power Button for 4 seconds or press “Start Menu” > 

“Suspend” to turn off the system. 
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3   Using the System 
 

3-1 Wi-Fi Connection Settings 

3-1-1 Connecting to an Existing Network 
 
Enable Wireless Connection 

        
1. Enable the Wireless Connection by choosing as steps of “Start” > 

“Settings” > “Control Panel” > “Network and Dial-up Connections”. 

2. Right click on the “GPS186861” and tap the “Enable” icon in the 

drop down menu to access the wireless connection. 

3. After enable the “GPSI86861”, you will see the icon    appears in 

the system tray. 



 

 25

Select a Network and get connection 

   

4. You will see the “GPSI86861” window pop up after you double click 

on the icon    .  

5. Press “Main” tab and “Configure” button. 

6. Select the network you want and put the key (password) if needed, 

then press “Connect” button to get connection.  

 NOTE: You can create a new network by selecting “Add 

New…” (please see Chapter 3-1-2 ) 

 
7. After WiFi is successfully connected, the screen will pop up a 

message showing the status of the connecting condition and the 

icon     in he system tray will turn to icon   . 
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3-1-2 Adding a New Network 

To add a new network connection, please enable the wireless connection 

first by following the steps in Chapter 3-1-1. 

 

 
1. The “Wireless Properties” dialog box pop up after pressing “Add 

New…”.   

2. To put a network name you want in “Network name (SSID)” text 

box, select “Encryption” and “Authentication” and enter password 

in the “Network key” to access a new network point existing in you 

place.  

3. Wireless successfully connected when Status showing “Connected 

to xxx”. 

 

 



 

 27

3-1-3 Enhancing the WiFi Connection 

If the status of WiFi Connection stays low, please follow the below steps:  

 

       

1. Please double-click on the icon    in the system tray. The 

“GSP186861” dialog will appear. 

2. Please select “Advance” tab and move the “Power Management” to 

the “Best Performance level” and the “Roaming Feature” to the far 

right. 

3. Press “OK” to save the settings. 
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3-1-4 SSID Lock Function 

      
 

1. Enable Wireless Connection by following the steps in Chapter 

3-1-1. 

2. After enable the Wireless Connection, the icon     will appear in 

the system tray. Double click the icon    and press “configure” 

button on the “GPSI86861” window. “Windows Information” window 

will appear. 

3. Select a network you want and click the “Lock to specific SSID” 

check box. Click “Connect” button to lock the SSID. 

4. SSID is locked successfully by showing “Status” as” Connected 

to.…” on the “Wireless Information” window. 
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3-2 Connecting to a Bluetooth Device 

3-2-1 Turning on the Bluetooth Connection 

 

        

1. Enable the Bluetooth Connection by following the steps “Start” > 

“Settings” > “Control Panel” > “Bluetooth Device”. 

2. Select “Config” tab In the “Bluetooth Manager “ dialog box. 

3. Press “Turn Bluetooth ON” button to “Turn Bluetooth Off” to enable 

the Bluetooth connection. 
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3-2-2 Scanning Bluetooth Devices 

We can scan the devices in a area and active their services in a “Bluetooth 

Manger” dialog by selecting “Start” > “Settings” > “Control Panel” > 

“Bluetooth Device”.  

 

 

1. To turn on the Bluetooth Connection. (Chapter 3-2-1) 

2. Select “Scan Device” tab in the “Bluetooth Manager dialog box”. 

3. Press “Scan Device” button to scan the surrounding Bluetooth 

devices. 

4. Select a Bluetooth device you want listing in the “Device menu” 

and press “Add Device” button. 

 Note: Please refer to the Chapter 4-1-10 for Programming 

Interface of Bluetooth. 
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3-2-3 Connecting to a Bluetooth Printer 

Please perform the steps in the Chapter 3-2-1 to turn the Bluetooth on and 

the Chapter 3-2-2 to scan the surrounding Bluetooth device first. 
 

 

Paring a Bluetooth Printer Device 
In Bluetooth, you have the option to "pair" two devices. When you pair with 

a Bluetooth device, this device will be "remembered” that means you need 

not search for the device again when you want to use the device next time.  
 

     
1. Select a Bluetooth printer device you want on the Device list after 

tapping on the “Scan Devices” button. 

2. Press “Add Device” button. A “Bluetooth Manager” dialog box will 

pop up.  

3. Press “Yes” button to authenticate (pair) the mobile system and the 

printer device.  

4. A PIN code is request when paring to a printer device. 

5. Enter the pin code to complete the authentication. 
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Active Printer Service 
 

    
1. Tapping on the Bluetooth Printer device you want and choose a 

service on the “Service” menu. The current example is selecting 

“Printer” service. 

2. Press “Active Service” button to active the Printer service. A “Serial 

Port Setting” dialog box will appear. 

3. Choose the COM port options in the drop down list you want.  

4. Press “OK”. 
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3-2-4 To Synchronize with a PC via Bluetooth 

Before Synchronize the Mobile System with a PC, please turn on the 

Bluetooth connection as described in the Chapter 3-2-1 and pair the PC 

and the Mobile System first as detailed in the below. 

 

 

 
Pairing a Bluetooth enabled PC 

When you pair with a Bluetooth device, this device will be "remembered” 

that means you need not search for the device again when you want to use 

the device next time.  

 

       

1. To turn on the Bluetooth Connection first, see Chapter 3-2-1. 

2. Select a Bluetooth enabled PC device you want in the “Device” list.  

3. Press “Add Device” button. A “Bluetooth Manager” dialog box will 

pop up. 

4. Press “Yes” button to authenticate the Mobile System and the PC. 
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5. A PIN Entry request will pop up on the 2 Bluetooth connecting 

devices for paring.  

 Note: Here is an example screen captured from the IVT 

Bluetooth dongle and the pertaining AP installed on the PC. 

 
6. Enter the same pin code on both sides. 

 

    
7. Select service at “Service” menu you want. Here we choose 

“ASYNC” service.  

8. Press “Active Service” button. 
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Installing the Microsoft ActiveSync 
To synchronize the Mobile System with a PC, we need to install the 

Microsoft ActiveSync Program on the PC. Please refer the detail 

installation procedures to the Microsoft official website. 

 

 

 

Check the Assigned Bluetooth Serial Com Port 
Check to see what the Bluetooth serial port is assigned. The COM port is 

assigned according to the Bluetooth Device you use. It is only checked for 

the first time. 

 

The following Bluetooth Settings window is captured by IVT Bluetooth 

dongle and the pertaining AP. The screen various according to the AP you 

install. 

 

 

1. Open the Bluetooth AP and check the COM Port that is assigned. 

2. Select the “View” > “Service” menu on the toolbar of IVT AP. We 

will see the assigned Serial Port. In this case, it is mapped to 

COM7 or COM8. We will need the assigned COM Port to set up for 

the Microsoft ActiveSync Program. The setting only happens in the 

first time. 
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Setup COM Port in the ActiveSync Program 
The COM port is only setup for the first time. 

 

      

1. Open the Microsoft ActiveSync Program on your PC. 

2. Choose “File” > “Connection Settings” menu on the toolbar. A 

“Connections Settings” dialog box will appear. 

3. Enable the “Allow connections to one of the following” check box 

and select the COM Port options. In this case we choose COM 7. 

4. Press “OK” button to save the connection settings. 

 

 

 
Connecting the Mobile System to the Bluetooth enabled PC 
 

      
1. Click “Start” > “Run” to run ”repllog” in the text box.  

2. Press “OK” button. A “Bluetooth Status” dialog box will pop up. 
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Press “Hide” to hide the message. 

3. After running the “repllog”, the Mobile System connects to the PC 

automatically and a “New Partnership” is requested to set up for 

the first time. 

 

 

 
4. Press “Next” button. 

 

 

 

 

 
5. A “Select Synchronization Settings” window will appear.  

6. Press “Setting” for your own setting inquiry. 

7. Press “Next” button to the “Setup Complete Window”. 
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8. To press “Finish” button to complete the setup procedure. 

 

 

 
Disconnecting the PC 
 

 
1. Go to “Start” > “Settings” > “Control Panel” > “Bluetooth Device” on 

the Mobile System. 

2. Press “Deactive Service” button to disable the service and 

disconnect the PC. 
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3-2-5 Bluetooth File Transfer (FTP) 

To transfer files from a PC to the Mobile System, please turn on the 

Bluetooth connection and scanning the Bluetooth enabled PC 

In this case, we use IVT Bluetooth Dongle and the pertaining AP as an 

example. The screen various according to the AP you install. 

 
 

   
1. Enabling the Bluetooth connection, see the Chapter 3-2-1. 

2. Scanning the destination PC, see the Chapter 3-2-2. 

3. Press “Bluetooth File Transfer Service” on the IVT Bluetooth AP. A 

“Remote Shared Folder” window will appear. 

4. Put files on it by performing copy-and-past. 

 

 

 

5. Right Click on the file and press “Execute” to transfer the file to 

your system. 
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Access the files on the Mobile System 

   

1. To Select “My Device” icon on Today Screen. 

2. Click “View” > “Options” on the toolbar. 

3. To disable the 3 check boxes on the “Folder Options” dialog box. 

4. You will see the “Temp” folder appears on the “My Device” Window. 

 

 
5. If the files transferring is successful. It will create a “FTP” folder in 

the Temp Folder automatically. All the transferring files are put in 

the folder. 
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3-3 Synchronization via USB Cable 

3-3-1 Mini USB Cable 

There is only USB port with WindowsCE® ActiveSync® function to be 

exposed to software developer to develop and debug their software 

application. 

A specific application program located in “Application” Folder and named 

as “USB.EXE” to provide manual USB ActiveSync connection. 

A specific USB cable would be required. 

 
USB Cable Snapshot 
 

  

(To Mobile System)                                    (to PC) 

 

Optional USB Cable is for functioning Synchronization with PC and 

Software uploading or Debug. 
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3-3-2 Installing WindowsCE® ActiveSync® application 

To synchronize the Mobile System with PC, please install the “Microsoft 

Active Sync” program on each PC first. 

 

The set-up of a “Partnership” will be requested once after connecting the 

USB Cable to the Mobile System and PC. 

 

 

The Synchronization will be running automatically after “Microsoft Active 

Sync” and “Partnership Set-up” being installed successfully and the USB 

Cable is connected.  

Please refer the detail installation procedure of ActiveSync program to the 

Microsoft official website. 

3-3-3 Installing the USB Cable 

 
1. Unscrew the screw (x1) to open the I/O cover and connect the mini 

USB connector of the USB cable to the respective connector on 

mobile system and the USB connector to a PC. 
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3-3-4 Start the Synchronization 

The connection will automatically run and you can see the “USB Status” 

dialog pop up after you connect the mobile system and a PC with the mini 

USB cable provided. 

 

 Note: please install the “Microsoft® ActiveSync®” program at 

your PC before you start the synchronization.  

 

 

1. The “Microsoft ActiveSync” window will show “Connected” after 

USB Cable is successfully connected. 

 

 Note: To choose “Options” tab to set up the customized 

Synchronization items on your own. 
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2. Double click the “Mobile Device” icon by opening “My Computer” to 

access the documents or files saved in the Mobile System. 
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3-4 Backup and Restoring the System 
 

 

Go to “Start” > “Control Panel” > “Device Config”. 
 

 

 

3-4-1 Backup the System 

To restore the system, please follow the Chapter 3-4 and the steps below.  

 

     

1. Select “Backup” tab then enable the “Entire the registry on your 

device” and the “All your files on your device” check boxes. 
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2. Press “Browse” button if you want to specify the location Backup 

Files to be saved to. 

3. Press “Backup” button to start backup the system. 

 
 

 

3-4-2 Restoring the System 

To restore the system, please follow the Chapter 3-4 and the steps below.  

 

     
1. Press “Restore”. 

2. Press “OK” of “RESET NOW” dialog to finish the Restore. 

 Note: System Restore means to restore the system to the 

latest “Backup” version.  
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3-5 Switching the Admin / User mode 
 

   

1. Please follow below steps to access the Mode Change screen. 

“Start Menu” > “Settings“ > “Control Panel“ > “Password“ > Enter 

Password (default is 1111) 

2. The “Password Properties” dialog will popup after entering the 

password (default), select the Mode you want. Press “OK” to save 

the setting. 

3. If the mode being switched, the “Mode Changed” dialog will popup. 

Press “OK” to restart the system. 
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3-6 Power Management Settings 

3-6-1 CPU Power Mode Settings 

 

      
1. Select “Start” > ” Control Panel”  > ” FPM” button 

2. Select the mode you want on the “FPM” window. 

 Note: The CPU Power Consumption is ranked as: 

” Performance Mode” > ” Dynamic Power Management” > ” 

Power Saving Mode”. 
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3-6-2 System Configuring Power Mode Settings 

     

1. Click “Start” > ” Control Panel” > ” Power” button 

2. Select “Schemes” tab. 

3. Set up the power mode as “Battery Power” or “AC Power” in the 

“Power Scheme” drop down menu. 

4. To set up the times you want on each option for turning the Mobile 

System off or going to standby mode after a period of inactivity.  

a. Switch state to User Idle. 

b. Switch state to System Idle. 

c. Switch state to suspend. 

5. Press “OK” to save the settings. 
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3-6-3 Display Backlight Settings 

 

    

1. Go to “Start” > “Control Panel”. 

2. Double click on the “Display” icon. 

3. In the “Display Properties” window, select “Backlight” tab. 

4. You can enable the backlight savings by checking and setting 

turn-off time in the checkboxes of “Battery power…”, “External 

power…” and “Enable Dim Mode…”  

5. To drag the “Bright Level” slider on “MIN – MAX” scale for “Battery 

Power” and “External (AC) power”. 

6. Press ”OK” button to save the settings. 

 

 Note: If you enable the “Dim Mode”, the system runs “Dim 

Mode” prior to “Battery power” and “External power”. 
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3-6-4 WiFi Power Mode Settings 

 

      
1. To tap “Start” > ”Control Panel” > ”Network and Dial-up 

Connections” button. 

2. Hold to press “GSPI86861” button until the drop down menu 

appears. 

3. Press “Enable” in the drop down menu to active the WiFi 

Connection or press icon    in the system tray directly to active 

the “GSPI86861” setup window as above right figure. 

4. To tap the “Advance” tab of the “GSPI86861” setup window  

5. To set up the “Power Management” by dragging the slider on the 

“Best Performance – Best Battery” scale. 

 

 Note: To conserve more battery power, drag the slider 

toward the “Best Battery” which also reduces the WiFi signal 

performance.  

To improve signal performance, drag the slider toward the 

“Best Performance” which also consumes more power and 

shorten the battery life.  
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3-7 Display Rotation 
 

      

 
1. Open Start > Control Panel 

2. Press “Display” icon. 

3. Select “Rotate” tab in the “Display Properties” dialog. 

   

4. Check the options you want to set up for the display rotation mode. 

5. Display will rotate according to your previous setup. 
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3-8 LED Indicator Description 
The LED indicator is located at the same place with power button which is 

in the front of the Mobile System.  It indicates the status of Power on/off, 

the Main Battery and WiFi Link. The Description as follows:          

                                                                            

 

 

Green color LED:  Battery power charging state(S/W) 

LED ON: Battery power charging finished (100%) 

 

Orange color LED: Battery power charging state(S/W) 

LED ON: Battery power charging 

 

Blue color LED: Link status of WiFi manager (H/W) 

LED ON: WiFi link active 

 

Red color LED: Battery power state(S/W) 

LED Flash: Battery low 

LED ON: Critical battery low 
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3-9 Resetting the Mobile System 
The mobile system provides functions of “Reset to the factory default 

settings” and “cold boot”. The detail procedures as bellows:  

3-9-1 Reset to the Factory Default Settings 

 

    

 
1. Use a tool to gently press the “Reset Hole” once on the side of the 

mobile system while keep holding down the “Power Button” 

throughout until the system lead you to the calibration instruction 

window. 

2. Finish the calibration process to complete the “Reset to the factory 

default settings”. 
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3-9-2 Cold Boot 

Please refer the power button and the reset hole to Chapter 3-9-1. 

   
1. Press the “Reset Hole” and the “Power Button” at the same time. 

   

2. System reboot to Today Screen as above picture shows. 

 Note: Today Screen slightly varies according to the OS 

version installed. 
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3-10 OS Image Update steps 

3-10-1 Unzip the RAR compressed file to Micro SD root directory 

You will find two directories from the root directory of MicroSD card which the 

directories to be unzipped from RAR file. 

File descriptions: 

Directory 1: “CE5.0-Vxx.xx”   -- WindowsCE 5.0 OS image revision 

Including  : Eboot.bin    -- OS Image loader 

nk.bin       -- OS Image 

Target_m.txt    -- Image of system power manager 

 

Directory 2: “UpdateImage”           -- Image update tool 

Including  : OS_DOWNLOAD.exe    -- Execution file of Image update tool  

             OS_DOWNLOAD.cfg    -- Configuration file of Image update tool 

             MCU_UPDATE.exe        -- Companion file of Image update tool 

   FormatPartitionCE5.dll    -- WinCE5.0 driver of Image update tool 

   FormatPartitionCE6.dll    -- WinCE6.0 driver of Image update tool 
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3-10-2 Image update procedures 

 Execute image update tool 

1. Go to “UpdateImage” directory. 

2. Double click “OS_DOWNLOAD.exe” icon to run image update tool. 
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 Update OS image 

1. Check the settings of “OS” page of update image tool   

2. Click “DOWNLOAD” button to start OS image download procedure 

3. Cold boot and reset the system to factory default mode after download 

procedure completed 

 

 

 

 
 

 

 

 

XXXXXX
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4   Application Programming Interface  

4-1 Windows Embedded CE 5.0 Standard 
 

21BInterface Introduction 
Most of software programming interfaces of each device are following 

WindowCE standard architecture to be designed. 
- Core OS Service 

(http://msdn.microsoft.com/en-us/library/aa450512.aspx) 

- Kernel 

(http://msdn.microsoft.com/en-us/library/aa450998.aspx) 

 

 
22BProgramming interface of RAM file system  

- File system and storage management  

(http://msdn.microsoft.com/en-us/library/ms892386.aspx) 

 

 
23BProgramming interface of Persistent storage 

- Folder name: “Backup” 

- Block Drivers  

(HUhttp://msdn.microsoft.com/en-us/library/ms923712.aspxUH ) 

- File system and storage management  

( HUhttp://msdn.microsoft.com/en-us/library/ms892386.aspxUH ) 

 

 
Programming interface of Secure Digital Card 

- Folder name: “Storage Card” 

- Secure Digital Card Drivers  

(HUhttp://msdn.microsoft.com/en-us/library/ms923739.aspxUH ) 

- Block Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/ms923712.aspxUH ) 

- File system and storage management  

( HUhttp://msdn.microsoft.com/en-us/library/ms892386.aspx UH ) 
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25BProgramming interface of Audio 
- Audio  

( HUhttp://msdn.microsoft.com/en-us/library/ms890653.aspxUH ) 

- Audio Drivers 

( HUhttp://msdn.microsoft.com/en-us/library/aa910103.aspxUH ) 

 

 
26BProgramming interface of Display(LCD) 

- Shell and User Interface  

( HUhttp://msdn.microsoft.com/en-us/library/aa453940.aspxUH ) 

- Graphic  

( HUhttp://msdn.microsoft.com/en-us/library/ms923392.aspxUH ) 

- Display Drivers 

( HUhttp://msdn.microsoft.com/en-us/library/aa447505.aspxUH ) 

 

 
27BProgramming interface of USB Host 

- USB Host Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/ms923751.aspxUH ) 

- Shell, GWES, and User Interface  

( HUhttp://msdn.microsoft.com/en-us/library/aa932172.aspxUH ) 

 

 
28BProgramming interface of MSR Reader 

 

 
29BProgramming interface of USB Slave 

- USB Function Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/aa931533.aspxUH ) 

- USB Serial Host Driver  (Activesync) 

( HUhttp://msdn.microsoft.com/en-us/library/aa932783.aspxUH ) 

- File system and storage management (Card Reader) 

( HUhttp://msdn.microsoft.com/en-us/library/aa914412.aspxUH ) 

 

B 

31BProgramming interface of Bluetooth 
- Bluetooth HCI Transport Driver  

( HUhttp://msdn.microsoft.com/en-us/library/aa924569.aspxUH ) 

- Networking - Core 

( HUhttp://msdn.microsoft.com/en-us/library/aa917156.aspxUH ) 
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- Networking - Remote 

( HUhttp://msdn.microsoft.com/en-us/library/aa920180.aspxUH ) 

- Networking – Wireless (Bluetooth) 

( HUhttp://msdn.microsoft.com/en-us/library/aa917877.aspxUH ) 

 
 

31BProgramming interface of Wireless 
- Network Driver  

( HUhttp://msdn.microsoft.com/en-us/library/aa919639.aspxUH ) 

- Networking - Core 

( HUhttp://msdn.microsoft.com/en-us/library/aa917156.aspxUH ) 

- Networking - Remote 

( HUhttp://msdn.microsoft.com/en-us/library/aa920180.aspxUH ) 

- Networking – Wireless (Wi-Fi) 

( HUhttp://msdn.microsoft.com/en-us/library/aa916578.aspxUH ) 

 

 
32BProgramming interface of Touch 

- Touch Screen Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/aa925927.aspxUH ) 

- Shell, GWES, and User Interface  

( HUhttp://msdn.microsoft.com/en-us/library/aa932172.aspxUH ) 

 

 
33BProgramming interface of Button 

- Keyboard Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/aa932012.aspxUH ) 

- Shell, GWES, and User Interface  

( HUhttp://msdn.microsoft.com/en-us/library/aa932172.aspxUH ) 

 

 
34BProgramming interface of Vibrator 

- Notification LED Drivers  

( HUhttp://msdn.microsoft.com/en-us/library/aa925927.aspxUH ) 

- Shell, GWES, and User Interface  

( HUhttp://msdn.microsoft.com/en-us/library/aa932172.aspxUH ) 

 
35B 



 62

Programming interface of System Power 
- Battery Drivers (Battery) 

( HUhttp://msdn.microsoft.com/en-us/library/aa932396.aspxUH ) 

- Power Management (Power status – battery/DC) 

( HUhttp://msdn.microsoft.com/en-us/library/aa923906.aspxUH ) 

 

 
Programming interface of Power Management 

- Power Management  

( HUhttp://msdn.microsoft.com/en-us/library/aa923906.aspxUH ) 
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4-2 Non WindowsCE Standard 

4-2-1 Admin/User Mode Application  
 
Architecture Introduction: 

System provides three pair of directories to map the working folder of each 

operating mode. 

 

Working folders name of Admin mode 

/Windows/Desktop   

File folder for saving the shortcut of application program in the Desktop. 

/Windows/Programs   

File folder for saving the shortcut of application program in the Programs 

tab at start menu. 

/Windows/StartUp  

File folder for saving the shortcut of application program in the StartUp 

folder where to be used to auto-run the programs during OS booting 

phase . 

 

Working folders name of User mode 

/Windows/Desktop_   

File folder for saving the shortcut of application program in the Desktop. 

/Windows/Programs_   

File folder for saving the shortcut of application program in the Programs 

tab at start menu. 

/Windows/StartUp_  

File folder for saving the shortcut of application program in the StartUp 

folder where to be used to auto-run the programs during OS booting 

phase. 
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Switching between Admin mode and User mode 
There is a control box in control panel applet, named - “Password”, The 

Manufacturer redefine the password policy of WindowCE standard. The 

password control box should input the password in advance to enter the 

page for finding the selection items of changing the operating mode and/or 

reset the default password. The default password is “1111”. 

Step: 

1. Find Password control box from control panel applet. 

2. Enter password: “1111” (Default) 

3. Select User mode or Admin mode. 

4. Type the “OK” button of password properties control box. 

5. Type the “OK” button of “Mode Chang” dialog for double confirmation. 

6. System would reboot automatically to the selected mode. 
 

 

How to use this feature? 
System Integrator only has to copy the desired files to the working folders 

of each mode. 

It is impossible to change the operation mode by reset system to factory 

default.  

In case user forgets the password. The only way to achieve the password 

is to run the Manufacturer maintenance application by copying the 

application to SD card and cold reset the device. 

Step: 

1. Copy the desired files to the working folder of the operation mode 

2. Follow Section “Switch the operation mode between Admin mode and 

User mode” to switch operation mode. 
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4-2-2 Overwrite Factory Default  

 

Architecture Introduction: 
The Manufacturer provides a mechanism to merge the OEM application 

and OEM specific settings into WindowCE operating system during booting 

phase. This feature can make OEM stuffs as system default components. 

There are many benefits for device maintenance.  

It is a valuable feature for OEM doesn’t have to reinstall OEM programs 

after end user reset the device to factory default mode. This benefit also 

helps to reduce the RMA cost from OEM vender. 

Because of this system architecture, WindowCE operating system and 

OEM application programs are not merged together. So both parts can be 

upgraded separately. 

 
Architecture of the OEM Device Manager 

System Integrator should base on the directory structure of WindowCE to 

prepare the OEM installation files in SD card. All files in “GHARST” file 

directory would be copy into WindowCE file system during cold booting 

phase. By the way, the config files in “configfiles” directory are for system 

registry maintenance.  

 

 

 

GHARST 

Configfiles 
Oem.cfg 

System.cfg 

Windows 

Program Files 

My Documents 

Documents and Settings 

Temp 
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Merge an application program into default operating system 
by using the OEM Device Manager 

 

 Example: 

 
- For Auto-running the OEM application at booting phase of user 

mode when after reset to factory default. 

 

1. Create a file directory “GHARST” in root folder of SD card. 

2. Change into “GHART” folder to create directory “Windows”.  

3. Change into “Windows” folder to create directory “StartUp_”. 

4. Copy the OEM application file into “Windows->StartUp_” folder. 

[Second way is: copy OEM application file into “Windows” folder, 

creates a lnk file of OEM application and copy it into 

“Windows->StartUp_” folder. 

5. Put SD card into the SD socket on the device. 

6. Use OEM The device Manager to merge all files in “GHARST” folder in 

SD card into the device. After the file integration process, all OEM 

specify files will be the system default components of the device. 

 
- Place the OEM application at “Programs” folder in Windows Start 

menu - System running in user mode.   

1. Create a file directory “GHARST” in root folder of SD card. 

2. Change into “GHART” folder to create directory “Windows”.  

3. Change into “Windows” folder to create directory “Programs_”. 

4. Copy the OEM application file into “Windows->Programs_” folder. 

[Second way is: copy OEM application file into “Windows” folder, 

creates a lnk file of OEM application and copy it into 

“Windows->Programs_” folder] 

5. Put SD card into the SD socket on the device. 

6. Use OEM The device Manager to merge all files in “GHARST” folder in 

SD card into the device. After the file integration process, all OEM 

specify files will be the system default components of the device. 

 
How to overwrite the factory default settings by using the 
OEM Device Manager 
 

Two config files are used to modify the registry settings of factory default 

mode. System Integrator is easy to add and/or modify the registry key 

without upgraded the image of WindowsCE operating system. The way to 
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remove the registry key is to put empty to the key value in the config file. 

System.cfg – Using for early registry initialization stage at booting phase. 

Oem.cfg – Using for system registry initialization stage at booting phase. 
 

 Example: 
- Overwrite the factory default backlight level setting.   

1. Create a file directory “GHARST” in root folder of SD card. 

2. Change into “GHART” folder to create directory “configfiles”.  

3. Prepare the oem.cfg config file by text editor. 

Input following setting: 

             [HKEY_CURRENT_USER\ControlPanel\BackLight] 

      "BatteryBacklightLevel"=dword:7  

      "ACBacklightLevel"=dword:A 

 

4. Copy oem.cfg file into “configfiles” folder. 

5. Put SD card into the SD socket on device. 

6. Use OEM Device Manager to merge all files in “GHARST” folder in SD 

card into device. After the integration process, all OEM desired settings 

will be the system default settings of device. 

 
- Overwrite the default WiFi state to power on mode. (Default is 

power down)  

1. Create a file directory “GHARST” in root folder of SD card. 

2. Change into “GHART” folder to create directory “configfiles”.  

3. Prepare or modify the oem.cfg config file by text editor. 

Input following setting: 

[-HKEY_LOCAL_MACHINE\Comm\NdisPower] 

4. Store oem.cfg file into “configfiles” folder.     

5. Put SD card into the SD socket on device. 

6. Use the OEM device manager to merge all files in “GHARST” folder in 

SD card into device. After the integration process, all OEM desired 

settings will be the system default settings of device. 

 
- Remove a registry key from the registry in factory default settings 

Only have to put the key equal to empty. factory manager will remove the 

specify key from default system registry setting. 

Example:  
[HKEY_LOCAL_MACHINE\RegistryKey] 

    "ValueName"=   
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Overwrite Factory Default Registry Settings for OEM 
Customization (oem.cfg) 

<1> Bluetooth operating mode  

 [HKEY_LOCAL_MACHINE\System\State\Hardware\Bluetooth] 

  “BluetoothOn”=dword:1  ; 1-> BT on, 0->BT off 

  “BluetoothWakeUpEnable”=dword:0     ;1-> Enable, 0-> Disable 

 

<2> WiFi operating mode is off  

[HKEY_LOCAL_MACHINE\Comm\NdisPower] 

    “GSPI86861”=dword:4  ; 4->WiFi off 

WiFi operating mode is on 

[-HKEY_LOCAL_MACHINE\Comm\NdisPower]    

 

 

 [HKEY_LOCAL_MACHINE\Comm\GSPI86861\Parms] 

   “PowerMode” = dword:1  ; 0: Performance mode, 1: PS mode 

   “MultipleDTim”=dowrd:2   ; PS mode (0,1,2,3,4 –most power 

saving) 

 

<3> Screen rotation feature  

[HKEY_LOCAL_MACHINE\System\GDI\Rotation] 

   “Angle”=dword:1 ;(Decimal 0->0 degree, 90->90 degree, 180->180 

degree, 270->270 degree)   // Manual rotate mode 

   “AutoRotate”=dword:F    // Auto Rotate control 

    ; bit 15  = 0 (Manual rotate)   = 1 (Auto Rotate) 

    ; bit 0   = 0 (180 degree ignored) = 1 (180 degree accepted)    

    ; bit 1   = 0 (90 degree ignored)  = 1 (90 degree accepted)    

    ; bit 2   = 0 (0 degree ignored)  = 1 (0 degree accepted)    

    ; bit 3   = 0 (270 degree ignored)  = 1 (270 degree accepted)    

 

<4> Backlight control 

[HKEY_CURRENT_USER\ControlPanel\BackLight] 

  "BatteryBacklightLevel"=dword:7   // Backlight level of battery only 

  "ACBacklightLevel"=dword:A   // Backlight level of AC IN mode 

"BatteryTimeout"=dword:3c       // Backlight timeout value of battery 

only mode 

"ACTimeout"=dword:258    // Backlight timeout value of AC IN 

mode 

  "DimTimeOut"=dword:1E         // Backlight DIM mode timeout  
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  "UseBattery"=dword:0      // Battery only mode timeout 

Enable/Disable 

  "UseExt"=dword:0    // AC IN mode timeout Enable/Disable 

    "UseDim"=dword:0    // Backlight DIM mode 

Enable/Disable 

 

<5> CPU operating frequency control 

 Option1: Dynamic Mode 

 [HKEY_LOCAL_MACHINE\Drivers\BuiltIn\IPM] 

   "ProfileType"=dword:0  

  

Option2: Performance Mode 

 [HKEY_LOCAL_MACHINE\Drivers\BuiltIn\IPM] 

   "ProfileType"=dword:1   

"Speed"=dword:0   

 

Option3: Power Saving Mode 

 [HKEY_LOCAL_MACHINE\Drivers\BuiltIn\IPM] 

   "ProfileType"=dword:1   

"Speed"=dword:4   
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Application program of the OEM Device Manager 
  

 

 

 

System Layer : “system.cfg” file update 

OEM Layer : “oem.cfg” file update 

 

Press “OK” button to merge the GHARST directory and specified layer 

config files into OS image   

 

Snapshoot of OEM Device Manager 
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Overwrite display backlight settings 
Once the backlight is enabled, you can set separately both battery 

backlight setting and backlight setting of AC power. System Integrator can 

use Control Panel to change the setting values or modify the following 

registry keys to change settings. Note that the units for the timeout values 

are in seconds 

 

Registry Key: 

[HKEY_CURRENT_USER\ControlPanel\Backlight] 

 

Modify display backlight settings for AC power 

Values: 

- UseExt    : 1 (Enable/default) / 0 (Disable) 

- ACTimeout   : 15/30/60/120/300/600(default)/900/1800  

- ACBacklightLevel     : 0/1/2/3/4/5/6/7/8/9/10(default) 
 

Modify display backlight settings for battery power 

Values: 

- UseBattery    : 1 (Enable/default) / 0 (Disable) 

- BatteryTimeout   : 15/30/60(default)/120/300  

- BatteryBacklightLevel : 0/1/2/3/4/5/6/7(default)/8/9/10 

 

Modify display backlight settings for DIM mode  

Values: 

- UseDim   : 1 (Enable/default) / 0 (Disable) 

- DimTimeout  : 15/30(default)/60/120/300  
 

Example Code (Update backlight level) 

void UpdateRegistry(DWORD dwVal) 

{ 

 TCHAR szRegClass[] = TEXT("DWORD"); 

 HKEY hRegBacklight; 

 DWORD dwDisposition; 

 if(ERROR_SUCCESS == RegCreateKeyEx(HKEY_CURRENT_USER, 

L"ControlPanel\\Backlight", 0, szRegClass, 

REG_OPTION_NON_VOLATILE, 0, NULL, &hRegBacklight, 

&dwDisposition)) 

 { 

  LONG    lResult; 
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  DWORD   dwType = REG_DWORD; 

  DWORD   dwLen = sizeof(DWORD); 

 

  // Battery Level 

  lResult = RegSetValueEx(hRegBacklight, L"BatteryBacklightLevel", 0, 

dwType, (LPBYTE)&dwVal, dwLen); 

 

  // AC Level 

  lResult = RegSetValueEx(hRegBacklight, L"AcBacklightLevel", 0, 

dwType, (LPBYTE)&dwVal, dwLen); 

 } 

 RegCloseKey(hRegBacklight); 

} 
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4-2-3 Vibration notification feature 

A vibrator is designed into this device for notification usage. The vibrator 

driver is following the notification LED driver architecture of WindowCE to 

be developed. This architecture is easy for System Integrator using 

WindowCE NLED standard API for application development, and also 

provides the advantage of backward compatibility. 

 
Data Structure introduction 
 

struct NLED_SETTINGS_INFO 

    { 

    UINT    LedNum;      

    INT     OffOnBlink;    

    LONG    TotalCycleTime;  

    LONG    OnTime;         

    LONG    OffTime;        

    INT     MetaCycleOn;     

    INT     MetaCycleOff;     

    }; 

LedNum  

LED number. Virbrator is zero (0).  

OffOnBlink  

Current setting. The following table shows the defined values.  

Value  Description  

0 Off 

1 On 

2 Blink 

TotalCycleTime  

Total cycle time of a blink, in microseconds. (Not support – default 0) 

OnTime  

On time of the cycle, in microseconds. (Not support – default 0) 

OffTime  

Off time of the cycle, in microseconds. (Not support – default 0) 

MetaCycleOn  

Number of on blink cycles. (Not support – default 0) 
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MetaCycleOff  

Number of off blink cycles. (Not support – default 0) 

 

Example code 
 

#include "stdafx.h" 

 

NLED_SETTINGS_INFO ledSettingsInfo   = { 0 }; 

 

void SetVibratorOn(void) 

{ 

 ledSettingsInfo.LedNum = 0; 

 ledSettingsInfo.OffOnBlink = 0; 

 if(!NLedSetDevice(NLED_SETTINGS_INFO_ID,&ledSettingsInfo)) 

      MessageBox(L"NLED ghNLED = NULL!!",L"Error",MB_OK); 

    } 

 
 

 


